
Module 1: Getting started with Windows PowerShell 

Lab A: Configuring Windows PowerShell 

Exercise 1: Configuring the Windows PowerShell console application 

Task 1: Start the console application as Administrator and pin the Windows 
PowerShell icon to the taskbar 

1. On LON-CL1, click Start. 

2. Type powersh to display the Windows PowerShell icon. 

Note: Make sure that the icon name displays Windows PowerShell and not 
Windows PowerShell (x86). 

3. Right-click Windows PowerShell, and then select Run as administrator. 

4. Make sure that the window title bar reads Administrator and does not include 
the text (x86). This indicates that it is the 64-bit console application and that an 
administrator is running it. 

5. On the taskbar, right-click the Windows PowerShell icon, and then select Pin to 
taskbar. 

Note: The Windows PowerShell console should now be open, run by 
Administrator, and available on the taskbar for future use. 

Task 2: Configure the Windows PowerShell console application 

1. To configure Windows PowerShell to use the Consolas font: 

a. Select the control box in the upper-left corner of the Windows PowerShell 
console window. 

b. Select Properties. 

c. In the “Windows PowerShell” Properties dialog box, select the Font tab, and 
then, in the Font list, select Consolas. 

d. Select 16 in the Size list. 



2. To select alternate display colors, on the Colors tab, review the available 
Screen Text and Screen Background colors. 

Note: Experiment with various combinations. You can use the color picker to 
change colors quickly to improve readability. 

3. To resize the window and remove the horizontal scroll bar: 

a. On the Layout tab, in the Window Size settings, change the area’s Width and 
Height values until the Windows PowerShell console pane preview fits 
completely within the Window Preview area. 

b. On the Layout tab, in the Screen Buffer Size settings, change the Width value 
to be the same as the Width value in the Windows Size settings. 

4. Select OK. The console application should now be ready for use. 

Task 3: Start a shell transcript 

• In the Windows PowerShell console, type the following command, and then 
press Enter:  Start-Transcript C:\DayOne.txt 

Note: You have now started a transcript of your Windows PowerShell session. It 
will save all the commands you type and also the command output to the text file 
until you run Stop-Transcript or close the Windows PowerShell window. 

You can view the contents of the transcript at any time by opening 
C:\DayOne.txt. 

Results: After completing this exercise, you will have opened and configured the 
Windows PowerShell console application and configured its appearance and 
layout. 

 

Exercise 2: Configuring the Windows PowerShell ISE application 

Task 1: Open the Windows PowerShell ISE application as Administrator 

1. In the Windows PowerShell console, type ise, and then press Enter. 

Note: This method of opening the ISE will work correctly only when an 
administrator is running the console. 



2. Close the ISE window. 

3. Right-click the Windows PowerShell icon on the taskbar and then select Run 
ISE as Administrator. 

You should now be running Windows PowerShell ISE as Administrator. 

Task 2: Customize the appearance of the ISE to use the single-pane view, hide 
the Command pane, and adjust the font size 

1. To configure the ISE to use a single-pane view: 

a. On the Windows PowerShell ISE toolbar, select the Show Script Pane 
Maximized option. 

b. Select the Hide Script Pane up-arrow icon to display the console. 

2. Select the Show Command Add-on option to view the Command pane, if it is 
not showing. 

3. Select the Show-Command Add-on option to hide the Command pane. 

4. Use the slider in the lower-right corner of the window to adjust the font size 
until you can read it comfortably. 

5. Close the Windows PowerShell ISE and the Windows PowerShell windows. 

Results: After completing this exercise, you will have customized the appearance 
of the Windows PowerShell Integrated Scripting Environment (ISE) application. 

Task 3: Prepare for the next lab 

• Leave the virtual machines running for the next lab. 

 

Lab B: Finding and running basic commands 

Exercise 1: Finding commands 

Task 1: Find commands that will accomplish specified tasks 

1. On LON-CL1, on the task bar, right-click Windows PowerShell, and then select 
Run as Administrator. 



2. In the console, type one of the following commands, and then press Enter:                     
Get-Help *resolve* or: Get-Command *resolve* or: Get-Command -Verb resolve 

Note: The first two commands display a list of commands that use Resolve 
anywhere in their names. The third displays a list of commands that use the verb 
Resolve in their name. All three will return the same results in the lab 
environment. This should lead you to the Resolve-DNSName command. 

3. In the console, type one of the following commands, and then press Enter:                     
Get-Help *adapter* or: Get-Command *adapter* or:                                                                     
Get-Command -Noun *adapter* or: Get-Command -Verb Set -Noun *adapter* 

Note: The first three commands display a list of commands that use Adapter in 
their names. The fourth displays a list of commands that have Adapter in their 
names and use the Set verb. This should lead you to the Set-NetAdapter 
command. 

4. Run Get-Help Set-NetAdapter to view the help for that command. This should 
lead you to the -MACAddress parameter. 

5. In the console, type one of the following commands, and then press Enter:                        
Get-Help *sched* or: Get-Command *sched* or:                                                                         
Get-Module *sched* -ListAvailable 

Note: The first two commands display a list of commands that use Sched in their 
name. The third displays a list of modules with Sched in their name, which should 
lead you to the module ScheduledTasks. If you then run the command Get-
Command -Module *ScheduledTask*, you will see a list of commands in that 
module. This should lead you to the Enable-ScheduledTask command. 

6. In the console, type one of the following commands, and then press Enter:                 
Get-Command –Verb Block or: Get-Help *block* 

Note: These display a list of commands. This should lead you to the                                  
Block-SmbShareAccess command. Then, run Get-Help Block-SmbShareAccess to 
learn that the command applies a Deny entry to the file share discretionary access 
control list (DACL). 

7. In the console, type the following command, and then press Enter:                                      
Get-Help *branch* 



Note: This will cause the help system to conduct a full-text search, because no 
commands use branch in their names. A list of topics containing the text branch 
displays, but none appear related to clearing the BranchCache cache. 

8. In the console, type one of the following commands, and then press Enter:            
Get-Help *cache* or: Get-Command *cache* or: Get-Command -Verb clear 

Note: The first two commands will display a list of commands containing Cache in 
the name. The third displays a list of commands using the verb Clear in the name. 
Either way, you should discover the Clear-BCCache command. 

9. In the console, type one of the following commands, and then press Enter:                 
Get-Help *firewall* or: Get-Command *firewall* or: Get-Help *rule* or:                              
Get-Command *rule* 

Note: These display a list of commands that use those words in their names. This 
should lead you to the Get-NetFirewallRule command. 

10. In the console, type the following command, and then press Enter:                                      
Get-Help Get-NetFirewallRule –Full 

Note: This will display the help for the command. This should let you discover the –
Enabled parameter. 

11. In the console, type the following command, and then press Enter:                                    
Get-Help *address* 

Note: This will display a list of commands that use address in their names. This 
should lead you to the Get-NetIPAddress command. 

12. In the console, type the following command, and then press Enter:                                    
Get-Command –Verb suspend 

Note: This displays a list of commands that use the verb Suspend in their names. 
This should lead you to the Suspend-PrintJob command. 

13. In the console, type one of the following commands, and then press Enter: 
Get-Alias Type or: Get-Command –Noun *content* 

Note: The first command displays the alias definition for the Type command, 
which is the command used in cmd.exe to read text from a file. The second 



command returns a list of commands with Content in the noun portion of the 
name. This should lead you to the Get-Content command. 

Results: After completing this exercise, you will have demonstrated your ability to 
find new Windows PowerShell commands that perform specific tasks. 

 

Exercise 2: Running commands 

Task 1: Run commands to accomplish specified tasks 

1. Ensure you are signed in on the LON-CL1 virtual machine as 
Adatum\Administrator. 

2. To display a list of enabled firewall rules, in the console, type the following 
command, and then press Enter:  Get-NetFirewallRule -Enabled True 

3. To display a list of all local IPv4 addresses, in the console, type the following 
command, and then press Enter:  Get-NetIPAddress –AddressFamily IPv4 

4. To set the startup type of the Background Intelligent Transfer Service (BITS), in 
the console, type the following command, and then press Enter:                                                
Set-Service –Name BITS –StartupType Automatic 

5. To test the connection to LON-DC1, in the console, type the following 
command, and then press Enter:                                                                                                           
Test-Connection –ComputerName LON-DC1 –Quiet 

Note: This command returns only a True or False value, without any other output. 

6. To display the newest 10 entries from the Security event log, in the console, 
type the following command, and then press Enter:                                                                      
Get-EventLog –LogName Security –Newest 10 

Results: After completing this exercise, you will have demonstrated your ability to 
run Windows PowerShell commands by using correct command-line syntax. 

 

 

 



Exercise 3: Using About files 

Task 1: Locate and read About help files 

1. Ensure you are still signed in to LON-CL1 as Adatum\Administrator from the 
previous exercise. 

2. To find operators used for wildcard string comparison, in the console, type the 
following command, and then press Enter:  Get-Help *comparison* 

3. In the console, type the following command, and then press Enter:                                       
Get-Help about_comparison_operators -ShowWindow 

Notice the –Like operator in the about_Comparison_Operators help, which 
displays in a modal window. 

4. To find the -Like operator, in the Find text box, type wildcard, and then select 
Next. 

5. After reading the about_Comparison_Operators file, you should learn that 
typical operators are not case-sensitive. Specific case-sensitive operators are 
provided in about_Comparison_Operators. 

6. To display the COMPUTERNAME environment variable, in the console, type the 
following command, and then press Enter:  $env:computername 

You could read about this technique in about_environment_variables. 

7. In the console, type the following command, and then press Enter:                                    
Get-Help *signing* 

8. In the console, type the following command, and then press Enter:                                        
Get-Help about_signing 

9. Read about code signing. You should learn that makecert.exe is used to create 
a self-signed digital certificate. 

Results: After completing this exercise, you will have demonstrated your ability to 
locate help content in About files. 

Task 2: Prepare for the next module 



When you have finished the lab, revert the virtual machines to their initial state. 
To do this, perform the following steps: 

1. On the host computer, start Hyper-V Manager. 

2. In the Virtual Machines list, right-click 10961C-LON-DC1, and then click Revert. 

3. In the Revert Virtual Machine dialog box, click Revert. 

4. Repeat steps 2 and 3 for 10961C-LON-CL1. 


